“Information contained in this publication regarding device applications and the like is intended by way of suggestion only. No representation or warranty is given and no liability is assumed by Microchip Technology Incorporated with respect to the accuracy or use of such information. Use of Microchip’s products as critical components in life support systems is not authorized except with express written approval by Microchip. The Microchip logo and name are trademarks of Microchip Technology Incorporated. All rights reserved. All other trademarks mentioned herein are the property of their respective companies”.


The Microchip logo and name are trademarks of Microchip Technology Inc.

PIC is a registered trademark of Microchip Technology Inc. in the U.S.A.

PICSTART, PICMASTER and PRO MATE are trademarks of Microchip Technology Incorporated.

CompuServe is a registered trademark of CompuServe Incorporated.

Data I/O is a registered trademark of Data I/O Corporation.

Excel and Windows are registered trademarks of Microsoft Corporation.

IBM and PC/AT are registered trademarks of International Business Machines Corporation.

Intel is a registered trademark of Intel Corporation.

MS-DOS is a registered trademark of Microsoft Corporation.

Unisite is a registered trademark of UNIX System Labs./Novell, Incorporated.

All product/company trademarks mentioned herein are the property of their respective companies.
Table of Contents

Preface: Welcome ................................................................. 1
Feature List and Product Information .......................... 1

Chapter 1. Introduction ....................................................... 3
Product Definition .......................................................... 3
Documentation Layout .................................................... 3
Documentation Conventions ........................................ 4
Terms ............................................................................. 4
Assemble .................................................................... 4
BBS ........................................................................... 4
Caution ........................................................................ 4
Checksum ..................................................................... 5
COM ........................................................................... 5
Device Programmer ..................................................... 5
DCE ........................................................................... 5
DOS .......................................................................... 5
EPROM .......................................................................... 5
EEPROM ....................................................................... 5
Fuse ........................................................................... 5
HEX Code .................................................................... 5
Host Mode ..................................................................... 5
Host Interface Program ............................................. 5
Note ............................................................................. 6
Object Code ................................................................. 6
PC .............................................................................. 6
PIC16/17 ...................................................................... 6
Source Code ................................................................. 6
Warning ........................................................................ 6
Recommended Reading .................................................. 7
Warranty Registration ..................................................... 7
Customer Support ......................................................... 7

Chapter 2. Installation .......................................................... 9
Introduction ..................................................................... 9
Highlights ..................................................................... 9
Hardware Installation .................................................... 9
System Requirements .................................................... 9
Cable Requirements ................................................. 10
Power Supply .............................................................. 10
Software Installation ..................................................... 10
Installing MPS16C.EXE .................................................. 11
Setting Up ..................................................................... 11
Selecting a Serial Port ................................................ 12
HEX Data Formats ....................................................... 12
8-Bit Merged HEX Format (INHX8M) ....................... 13
Chapter 3. Using the PC Host Screen Displays
   Introduction ............................................................................. 15
   Highlights ................................................................................ 15
   PC Host Screen ...................................................................... 15
      Menu Bar ........................................................................ 16
      Window Area ..................................................................... 16
      Command Bar ..................................................................... 16

Chapter 4. Basic User Tasks
   Introduction ............................................................................. 17
   Highlights ................................................................................ 17
   Using the Device Programmer Basic Functions ..................... 18
   Programming a Microcontroller Device ................................. 18
   Verifying a Microcontroller Device ......................................... 18
   Checking for a Blank Device ................................................... 18
   Reading a Device Master ......................................................... 18
   PC Host Mode ......................................................................... 19
      Programming a Device in PC Host Mode ............................. 20

Chapter 5. Supporting User Tasks
   Introduction ............................................................................. 23
   Highlights ................................................................................ 23
   Editing the Display Window ..................................................... 23
      Edit .............................................................................. 24
      Fill .............................................................................. 25
   Configuring Fuses ................................................................... 25

Chapter 6. Host User Interface
   Introduction ............................................................................. 27
   Highlights ................................................................................ 27
   PC Host Connect Mode ............................................................ 27
   Command Line Options ........................................................... 27
   Menu Bar ............................................................................. 28
      File ............................................................................. 29
      Edit ............................................................................. 29
      Program ......................................................................... 30
      Option ........................................................................... 30
      Windows ......................................................................... 31
      Help ............................................................................. 31
   Display Area ............................................................................ 32
   Command Bar ........................................................................ 32
# Table of Contents

<table>
<thead>
<tr>
<th>Appendix A. BBS Support</th>
<th>.................................................................</th>
<th>35</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keeping Current with Microchip Systems</td>
<td>..................................................................</td>
<td>35</td>
</tr>
<tr>
<td>Highlights</td>
<td>..................................................................</td>
<td>35</td>
</tr>
<tr>
<td>Connecting to Microchip BBS</td>
<td>..................................................................</td>
<td>36</td>
</tr>
<tr>
<td>Using the Bulletin Board</td>
<td>..................................................................</td>
<td>37</td>
</tr>
<tr>
<td>Special Interest Groups</td>
<td>..................................................................</td>
<td>37</td>
</tr>
<tr>
<td>Files</td>
<td>..................................................................</td>
<td>37</td>
</tr>
<tr>
<td>Mail</td>
<td>..................................................................</td>
<td>38</td>
</tr>
<tr>
<td>Software Releases</td>
<td>..................................................................</td>
<td>38</td>
</tr>
<tr>
<td>Alpha Release</td>
<td>..................................................................</td>
<td>38</td>
</tr>
<tr>
<td>Intermediate Release</td>
<td>..................................................................</td>
<td>39</td>
</tr>
<tr>
<td>Beta Release</td>
<td>..................................................................</td>
<td>39</td>
</tr>
<tr>
<td>Production Release</td>
<td>..................................................................</td>
<td>39</td>
</tr>
<tr>
<td>Appendix B. Error Messages</td>
<td>..................................................................</td>
<td>41</td>
</tr>
<tr>
<td>Introduction</td>
<td>..................................................................</td>
<td>41</td>
</tr>
<tr>
<td>Highlights</td>
<td>..................................................................</td>
<td>41</td>
</tr>
<tr>
<td>Host Interface Program Messages</td>
<td>..................................................................</td>
<td>41</td>
</tr>
<tr>
<td>Appendix C. Troubleshooting</td>
<td>..................................................................</td>
<td>47</td>
</tr>
<tr>
<td>Introduction</td>
<td>..................................................................</td>
<td>47</td>
</tr>
<tr>
<td>Highlights</td>
<td>..................................................................</td>
<td>47</td>
</tr>
<tr>
<td>Typical Problems in Programming Devices</td>
<td>..................................................................</td>
<td>48</td>
</tr>
<tr>
<td>Communication Failure</td>
<td>..................................................................</td>
<td>48</td>
</tr>
<tr>
<td>Disabled Mouse</td>
<td>..................................................................</td>
<td>48</td>
</tr>
<tr>
<td>Establishing Communication</td>
<td>..................................................................</td>
<td>48</td>
</tr>
<tr>
<td>Index</td>
<td>..................................................................</td>
<td>49</td>
</tr>
<tr>
<td>Worldwide Sales and Service</td>
<td>..................................................................</td>
<td>52</td>
</tr>
</tbody>
</table>
Welcome

Congratulations on selecting the PICSTART-16C CMOS Microchip Microcontroller Device Programmer from Microchip Technology. The PICSTART-16C Device Programmer enables you to quickly and easily program user software into PIC16C64 and PIC16C74 CMOS microcontroller devices. (It is also designed to support future 28 pin versions).

Note: The PICSTART is designed for Development only and is not intended for production use!

Feature List and Product Information

The PICSTART-16C Device Programmer is an EPROM programmer system that:

- Programs the EPROM microcontroller devices for the PIC16C64 and PIC16C74.
- Operates with a PC compatible host system.
- Provides PC host software for displaying and editing files and for transferring files to and from the Device Programmer.
- Communicates via standard RS-232 cable.

The PICSTART-16C Device Programmer comes with the following accessories for you to use with the PC Host computer:

- RS-232 Interface Cables and Connectors to a standard PC serial port
- Universal Input Power Supply
- Host Operating Software
Chapter 1. Introduction

Product Definition

PICSTART-16C is a DOS-based device programmer that interfaces with a PC host to provide product developers with the ability to program user software into the PIC16C64 and PIC16C74 Microchip CMOS microcontroller families.

The Host Interface Program, MPS16C.EXE, allows you to operate the PICSTART-16C Device Programmer from a PC host. With the Host Interface Program, you can perform all device programmer functions as well as perform file manipulation.

Documentation Layout

This document describes how to use the PICSTART-16C Device Programmer with a PC Host. A detailed discussion of basic information about specific Microchip microcontrollers is deferred to the data sheets for the specific microcontrollers.

The manual layout is as follows:

Chapter 1: Introduction - This chapter introduces the PICSTART-16C Device Programmer. The Introduction also describes the layout of this User Guide, and lists terms and conventions used in this guide.

Chapter 2: Installation - Installation describes how to install the PICSTART-16C hardware and software.

Chapter 3: Using the PC Host Screen Displays - This chapter gives a quick look at the screen layout and display windows generated by the PICSTART-16C Host Interface Program.

Chapter 4: Basic User Tasks - This chapter describes the basic tasks that you must perform to program a microcontroller device with the PICSTART-16C Device Programmer.

Chapter 5: Supporting User Tasks - This chapter describes additional supporting tasks that you may need to do when programming a microcontroller device.

Chapter 6: Host User Interface - This chapter describes how to program microcontroller devices by using the menu options and commands available at the PC Host.

Appendix A: BBS Support - Appendix A provides information about accessing the Microchip Bulletin Board for the latest revisions of products, user forums and non-urgent questions about applying Microchip products.
Appendix B: Error Messages - This appendix lists the possible PICSTART-16C error messages with a description of each message.

Appendix C: Troubleshooting - This appendix provides reference information to help you in troubleshooting.

Documentation Conventions

This manual uses the following documentation conventions.

Table 1.1 - Documentation Conventions

<table>
<thead>
<tr>
<th>Character</th>
<th>Represents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Square Brackets ( [ ] )</td>
<td>Optional Arguments</td>
</tr>
<tr>
<td>Angle Brackets ( &lt; &gt; )</td>
<td>Delimiters for special keys: &lt;TAB&gt;, &lt;ESC&gt;, etc.</td>
</tr>
<tr>
<td>Pipe Character (</td>
<td>)</td>
</tr>
<tr>
<td>Lower case characters</td>
<td>Type of data</td>
</tr>
<tr>
<td>Italic characters</td>
<td>A variable argument; it can be either a type of data (in lower case characters or a specific example (in uppercase characters)</td>
</tr>
<tr>
<td>Courier Font</td>
<td>User entered code or sample code</td>
</tr>
<tr>
<td>Underscored, Italicized</td>
<td>Defines a menu selection from the menu bar:</td>
</tr>
<tr>
<td>Text with Right Arrow</td>
<td><em>File ➤ Change Dir</em> (Menu Items)</td>
</tr>
</tbody>
</table>

Terms

To provide a common frame of reference, this manual defines the following terms:

Assemble

The act of translating source code into relocatable object code.

BBS

The Bulletin Board System provided by Microchip Technology Inc.

Caution

The caution alerts you to a situation that would cause physical damage to a device, software file, or equipment. A caution is non life threatening.
Chapter 1: Introduction

Checksum
The checksum is a four-digit, 16-bit value used to identify properly programmed microcontroller devices. The checksum is equal to the sum of all memory locations and fuses.

COM
A serial communications port on the PC Host that the Device Programmer communicates with. The default serial port is COM1. You may also select COM2, COM3, or COM4.

Device Programmer
PICSTART-16C Device Programmer

DCE
Data Communication Equipment

DOS
Disk Operating System that provides the basis for most applications that run on the PC Host.

EPROM
Erasable Programmable Read Only Memory.

EEPROM
Electrically Erasable Programmable Read Only Memory.

Fuse
PIC16/17 microcontrollers contain configuration fuse bits which can be programmed to set various modes of operation. In OTP PIC16/17 devices, some fuses may be preprogrammed. In windowed devices, fuses are left blank.

HEX Code
A file of executable instructions assembled from source code into relocatable HEX code. Object code is programmed into microcontroller devices. HEX code is also referred to as object code.

Host Mode
In the PC Host Connect Mode, the Device Programmer interfaces with the PC Host and receives download data from the host.

Host Interface Program
The PICSTART-16C software, MPS16C.EXE, running on the PC Host.
Note
A note alerts you to important related information that may help you perform a task.

Object Code
A file of executable instructions assembled from source code into relocatable object code. Object code is programmed into microcontroller devices. Object code is also referred to as HEX code.

PC
Any IBM® or compatible Personal Computer.

PIC16/17
PIC16/17 refers to the PIC16C5X, PIC16CXX, and PIC17CXX Microchip microcontroller families.

Source Code
Source code is an ASCII file of microcontroller device instructions that will be translated into executable code. The source code can be created with any ASCII text editor.

Warning
The warning alerts you to a potentially life threatening situation.
Chapter 1: Introduction

Recommended Reading

This manual describes how to use the PICSTART-16C Device Programmer. You may also want to read the Data Sheets for the microcontroller device that you are programming.

For the latest information on using the Device Programmer, read the README.1ST file on the PICSTART-16C diskette. The file contains update information that may not be included in this manual.

The Microchip “Embedded Control Handbook” also contains a wealth of information about microcontroller applications. These applications are available from the Microchip BBS.

All of these documents are available from your local sales office, or your Microchip Field Application Engineer (FAE).

Warranty Registration

Upon receiving the PICSTART-16C diskette you should complete and return the Warranty Registration Card enclosed with the disk, and mail it promptly. Sending in your Warranty Registration Card will help to ensure that you receive new product updates and notification of interim releases that may become available.

Customer Support

Microchip is committed to providing the support you need to successfully develop applications using Microchip microcontrollers. Your first line of defense should always be your distributors and representatives, local sales office or Field Application Engineer (FAE).

You can also check with the Microchip BBS (Bulletin Board System) for non-urgent support, customer forums, and the latest revisions of Microchip systems development products. Additionally, the Microchip Factory Application Group can provide support. Refer to the Appendix for details on accessing the BBS.
Chapter 2. Installation

Introduction

This chapter describes the procedures for installing the PICSTART-16C Device Programmer hardware and software.

Highlights

The installation information covered in this chapter includes:

Hardware Installation

- System Requirements
- Cable Requirements
- Power Supply

Software Installation

- Installing MPS16C.EXE
- Selecting a Serial Port
- HEX Data Formats
  - 8-Bit Merged HEX Format (INHX8M)

Hardware Installation

System Requirements

IBM PC/AT® compatible with:
- 1.44 Meg Floppy Disk Drive, 3.5"
- Hard Drive
- One Available Serial Port (COM1 - COM4)
- 640K RAM (min)
- DOS 4.1 or Greater
- Mouse (recommended)
- VGA (recommended)

The PICSTART-16C Host Interface Program will run on any PC/AT or compatible computer, running DOS V4.1 or greater, and with one available serial (COM) port. The distribution is provided on 3.5", high density (1.44M) floppy diskettes.

No special display or ancillary devices are required. Microchip recommends using a color display and a mouse.
Cable Requirements

The Device Programmer provides communication via an RS-232 9-pin D type connector. The PICSTART-16C is DCE. Hardware handshaking is via CTS, and RTS.

A 6-foot male-to-female data cable with 9-pin DB-9 connectors is supplied with the Device Programmer. All lines on the data cable are wired straight through. (This cable is NOT a null modem cable.)

The following table gives the data for connecting the PICSTART-16C Device Programmer to a 25-Pin serial port. Connect the corresponding terminals indicated on each line of the table. If communication fails, check your PC serial port.

<table>
<thead>
<tr>
<th>25-Pin Female (PC Host)</th>
<th>9-Pin Male (PICSTART-16C)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 TX</td>
<td>3 RX</td>
</tr>
<tr>
<td>3 RX</td>
<td>2 TX</td>
</tr>
<tr>
<td>20 DTR</td>
<td>4 Data Ready</td>
</tr>
<tr>
<td>7 Ground</td>
<td>5 Ground</td>
</tr>
<tr>
<td>6 DSR</td>
<td>6 pulled up to 5V</td>
</tr>
<tr>
<td>4 RTS</td>
<td>7 CTS</td>
</tr>
<tr>
<td>5 CTS</td>
<td>8 RTS</td>
</tr>
</tbody>
</table>

Power Supply

The PICSTART-16C comes with a universal input power supply with IEC power cord connector.

The PICSTART-16C Device Programmer requires +9 Volts ± 10% at 500 mA (max) on center positive 2.5 mm.

Software Installation

Prior to installing software, make a backup copy of the Device Programmer Distribution Disk using the DOS DISKCOPY program. After making a backup copy, label the new copy and store the original in a safe place. Never use the original diskette as your working copy.

For information on using DISKCOPY or any DOS command, and DOS environment variables, refer to your DOS user’s guide.
Installing MPS16C.EXE

Microchip recommends that you execute MPS16C.EXE from your hard disk. If you want to run MPS16C.EXE from any directory (without fully qualifying the path to the executable program), you must add the new directory to the DOS PATH environment variable.

Run the Device Programmer Host Interface Program by typing MPS16C at the DOS prompt. The PC Host will attempt to establish communication with the Device Programmer upon starting the Host Interface Program. If communication can not be established, no programming can occur. A dialog box will appear if the attempt to establish communication fails. If a communication attempt fails, try again after correcting the problem, or cancel. If you cancel, the Device Programmer will operate normally until it attempts to access TO/FROM information; the Device Programmer will then attempt to establish communication again. See detailed description below.

Setting Up

This section will guide you through the starting up procedures of the PICSTART-16C Device Programmer. It will discuss what equipment is needed and how to load the software onto a hard drive.

STEP 1: Loading the software

Change to floppy drive:

A: <RETURN>

Run INSTALL:

INSTALL <RETURN>

You will be prompted for the destination of the PICSTART-16C files. INSTALL will then install all necessary files.

Note: Use the latest revision of the software disk contained in the package. Updated software may have been added after initial packaging was done.

STEP 2: Connecting to PC

Connect the RS-232 nine pin male to female, straight through cable (NOT Null Modem), to an open serial port on the PC (COM1 is the software default). If your PC has a 25 pin serial port, refer to cable requirements for a 25-to-9 pin wire diagram.
STEP 3: Supplying Power

Connect the 9 volt power supply (provided) to the PICSTART-16C.

STEP 4: Executing the Program

At the DOS prompt, type MPS16C to start the program. MPS16C will now try to establish communication with the PICSTART-16C. PICSTART-16C uses COM1 as the default port. If another port is desired, type MPS16C-x where x is the desired COM port. COM ports 1 through 4 are valid (see selecting a serial port below).

MPS16C.EXE is a DOS based windowed program. You may run MPS16C.EXE from a keyboard, or through mouse inputs. If you use a mouse, you must install a mouse driver prior to evoking the Device Programmer Host Interface Program. Consult your specific mouse documentation for proper installation for your mouse. If you do not use a mouse, press the TAB key to move the cursor to the next field in any dialog box, and make selections from the keyboard.

Selecting a Serial Port

Use the command line option from the MPS16C.EXE software running on the PC Host to select the serial port that the host will use to communicate to the Device Programmer. The default serial port is COM1. Valid ports are COM1 through COM4. If you are using a serial port other than COM1, specify the desired port number by typing MPS16C, space, slash, and the port number on the command line:

MPS16C /n <CR> where n = 2, 3, or 4

Connect the RS-232 cable to a serial port on the PC Host and to the Device Programmer.

A flashing message Establishing Communication indicates that the Device Programmer is trying to initialize a mouse or a modem. Type Control C (^C) to exit.

HEX Data Formats

The Device Programmer uses the formats described in the following paragraphs as follows:

PIC16C6X/7X Uses INHX8M

To provide the proper file format when assembling your file, ensure that you use the proper assembler switches.
8-Bit Merged HEX Format (INHX8M)

This format produces one 8-bit HEX file with a low byte, high byte combination. Since each address can only contain 8 bits in this format, all addresses are doubled.

Each data record begins with a 9 character prefix and ends with a 2 character checksum. Each record has the following format:

:BBAAATTHHHH....HHHCC

where

BB - A two digit hexadecimal byte count representing the number of data bytes that will appear on the line.

AAAA - A four digit hexadecimal address representing the starting address of the data record.

TT - A two digit record type that will always be 00 except for the end-of-file record, which will be 01.

HH - A two digit hexadecimal data word, presented in low byte, high byte combinations.

CC - A two digit hexadecimal checksum that is the two's compliment of the sum of all preceding bytes in the record including the prefix.
Chapter 3. Using the PC Host Screen Displays

Introduction

The Host Interface Program allows you to interface with the Device Programmer from a PC Host to program the PIC16C64/74 with code that you generate.

Highlights

This chapter describes the screen and display window functions of the Host Interface Program as follows:

- PC Host Screen
- Display Windows

PC Host Screen

The screen on the PC Host consists of three basic sections: the Menu Bar, Window Area, and Command Bar.

Figure 3.1 - PC Host Screen
MenuBar
The Menu Bar allows you to perform operations and to set-up the system for programming.

Window Area
The Window area provides a space for displaying information in memory and for displaying menus.

Command Bar
The Command Bar provides single keystroke commands or mouse clicks for programming microcontroller devices.

Display Windows
The Host Interface Program provides four display windows. All display windows are scrollable and sizable with the cursor movement keys or with a mouse.

- **Main Program Memory Window**: Displays the HEX contents of the program memory.
- **Main Program Memory Error Window**: Displays errors in the main program memory during program or verify.
- **Fuses Error Window**: Displays errors in Fuses during program or verify.
Chapter 4. Basic User Tasks

Introduction
This chapter contains flow charts showing how to perform the basic user task of programming a microcontroller device. The chapter also provides a user example for PC Host Mode.

Highlights
The information in this chapter includes PC Host Mode as follows:

Using the Device Programmer Basic Functions
Programming a Device in PC Host Mode
• Selecting a microcontroller device
• Loading a HEX file
• Setting fuses

Using PC Host Mode Basic Functions

User Examples
• PC Host Mode programming example
Using the Device Programmer Basic Functions

The Device Programmer performs the following basic functions associated with programming a microcontroller device.

Programming a Microcontroller Device

1. The Device Programmer checks to see if the installed microcontroller device is blank. If the microcontroller device is not blank, the Device Programmer asks if you want to continue.

2. The Device Programmer programs the contents of its memory to the microcontroller device loaded in the socket.

3. The Device Programmer performs a check to verify the data programmed into the microcontroller device, and returns the results of the verification.

Verifying a Microcontroller Device

1. The Device Programmer compares the contents of its memory to the contents of the microcontroller device.

2. The Device Programmer reports results of the verification. Reported results include the following:
   • Same Contents
   • Errors

Checking for a Blank Device

1. The Device Programmer checks the microcontroller device to verify that all program locations contain ones (the erased state).

Reading a Device Master

1. The Device Programmer reads the microcontroller device contents and copies the contents of the microcontroller device into the PC Host Buffer Memory.
PC Host Mode

The following flowchart graphically shows the basic steps you must follow to program a microcontroller device in PC Host mode from the PC host.

![Flowchart showing basic steps in PC Host Mode]

**Step 1. Select a Device**

**Step 2. Load a HEX File**

**Step 3. Set Fuses**

**Step 4. Program a Device**

Blank Checking Device Now

- Device Not Blank
  - Continue? No → Programming Cycle Aborts
  - Continue? Yes → Programming Device Now

Programming Device Now

- Error Check
  - No Programming Errors
    - Program Complete
  - Program Error
    - Main Program Memory Error
      - Fuse Error

Figure 4.1 - Basic Steps in PC Host Mode
Programming a Device in PC Host Mode

To program a microcontroller device in the PC Host mode, you must do the following:

Step 1. Select and Load a Microcontroller Device

From the Config Window, select Device Edit. The PC Host displays a menu listing Microchip devices supported.

Select the microcontroller device that you will be programming. To select a different device, use the mouse, cursor keys, or number keys.

After selecting a microcontroller device, insert a device to be programmed into the socket on the Device Programmer. Position pin one on the device in the pin one position on the socket.

Note: A dot or notch on the device and socket identifies the pin one location.

Figure 4.2 - Pin One Location

Step 2. Load a HEX File

To load a HEX file, open the desired file from the File Open Menu Bar selection. Use File Change Dir if the file you want to open is in another directory.

Step 3. Set Fuses

Set fuses if needed in the Config Dialog Box by pressing the Fuse Edit button.

Step 4. Program a Microcontroller Device

The Program menu selection initiates programming of the microcontroller device as follows:

Checking Device — The Device Programmer performs a blank safety check to avoid reprogramming a non blank device.

Programming — The Host Interface Program transfers the data from the PC Host Screen Window to the Device Programmer. The Device Programmer then programs the data into the microcontroller device one location at a time. A status box appears and shows the current address being programmed.

Verifying — The Device Programmer verifies all memory locations.
Chapter 4: Basic User Tasks

User Examples

The following PICSTART-16C Device Programmer examples give you a step-by-step look at the procedures you must follow to program a Microchip PIC16C64 microcontroller device.

PCHostModeProgrammingExample

The following PC Host Mode example contains information and procedures to help you program the PIC16C64 Microchip microcontroller device from a PC Host.

Example Objective: Program a PIC16C64 device with a program from a PC Host, and disable code protect on the programmed device.

Preliminary Setup Requirements

<table>
<thead>
<tr>
<th>Device Type</th>
<th>PIC16C64</th>
</tr>
</thead>
<tbody>
<tr>
<td>HEX File</td>
<td>TUTOR.HEX on a floppy diskette</td>
</tr>
<tr>
<td>Loading Drive</td>
<td>B:</td>
</tr>
</tbody>
</table>

Setting Up Equipment and Loading a HEX File

Cable Connection

1. Connect the COM cable between the PC Host and PICSTART-16C.
2. Connect power to the Device

PC Host Setup

3. Type MPS16C at the PC Host. Press <ENTER>.
4. Select 16C64 from Device Menu.
5. Select the File ➤ Open pulldown menu.
6. Type B:TUTOR.HEX. Press <ENTER>.

The screen window now displays HEX code from B:SAMPLE.HEX.

7. From the Config. window, click on Fuse Edit or press the letter E.
   • Select the LP oscillator fuse in the OSC box.
   • Disable the watchdog timer by clicking the X to clear the selection.
   • Click OK.

Note: Code protect is disabled by default.
Programming a Device from the PC Host

1. Insert a blank PIC16C64 device in the socket module, and lower the locking lever on the ZIF socket.

2. Press the PC Host F5 Program function key. The host interface program transfers the code displayed in the screen window to the Device Programmer. When programming is complete, Program Complete displays on the PC Host screen window.

3. Click OK in the message window.

4. Remove the programmed device from the socket module.

5. Repeat steps 1-4 in this block to program additional devices.
Chapter 5. Supporting User Tasks

Introduction

This chapter describes how to use tasks that support programming with the Device Programmer.

Highlights

The highlighted information in this chapter includes:

- Edit the Display Window
- Configuring Fuses

Editing the Display Window

Press F4 to display the Edit Selection dialog box, and to edit the contents of the display window.

An Edit Selection dialog box allows you to Edit, Fill, or Cancel.

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Opens Edit Address for editing the display window.</td>
</tr>
<tr>
<td>Fill</td>
<td>Opens Fill Buffer to fill the display window with a constant value.</td>
</tr>
</tbody>
</table>
Edit

The Edit Address dialog box allows you select a specific address location (shown in the display window) to begin editing. Press F4, Edit to display the Edit Address dialog box. The Host Interface Program displays the Edit Address dialog box.

Edit Address Dialog Box

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Enter a specific address where you want to begin editing.</td>
</tr>
<tr>
<td>OK</td>
<td>Displays the contents of the selected address.</td>
</tr>
<tr>
<td>Cancel, or ESC</td>
<td>Cancels the Edit function.</td>
</tr>
</tbody>
</table>

The Edit Buffer dialog box allows you to enter new data values in specific address locations. Use Tab/Shift Tab to cycle through the selections. Use Enter to enter a data value and increment to the next address location.

Edit Buffer Dialog Box

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Enter a specific address that you want to edit.</td>
</tr>
<tr>
<td>Data</td>
<td>Enter a new data value.</td>
</tr>
<tr>
<td>OK</td>
<td>Updates the specified address with the displayed data value, and increments to the next address location.</td>
</tr>
<tr>
<td>Cancel, or ESC</td>
<td>Cancels the Edit function. When all edits are complete, press the CANCEL or ESCape key or click on the close box on the upper left corner of the window to exit the edit session.</td>
</tr>
</tbody>
</table>
Chapter 5: Supporting User Tasks

Fill

The Fill Buffer dialog box allows you fill a specific address range with a value. Use Tab/Shift Tab to cycle through the selections.

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Address</td>
<td>Enter the beginning address of the range you want to fill.</td>
</tr>
<tr>
<td>End Address</td>
<td>Enter the ending address of the range you want to fill.</td>
</tr>
<tr>
<td>Data</td>
<td>Enter the data value that you want to fill the specified address range.</td>
</tr>
<tr>
<td>OK</td>
<td>Fills the specified address range with the displayed data value, and exits the Edit function.</td>
</tr>
<tr>
<td>Cancel, or ESC</td>
<td>Cancels the Fill function.</td>
</tr>
</tbody>
</table>

Caution: Be sure to verify the start address and end address before filling with a data value.

Note: Any changes to the screen window will not be saved upon exit, so saving is required prior to issuing an exit command.

Configuring Fuses

Select Fuse Edit from the Config Window to configure the fuses for the microcontroller device loaded in the Device Programmer. Refer to the specific microcontroller device data sheet for more information regarding fuses. Fuse configuration selections may contain any or all of the following:

- Oscillator Type Fuses (LP, RC, XT, HS)
  (You can only set one Oscillator type fuse.)
- Watchdog Timer
- Power Up Timer
- Code Protect

Press OK to update your fuse selections. Click on Cancel or press ESC to escape from this menu.
Chapter 6. Host User Interface

Introduction

This chapter contains a description of the PC Host mode Menu Bar commands, the Display Area, and the Command Bar commands.

Highlights

The highlighted points in this chapter discuss the following:
- PC Host Connect Mode
- Menu Bar
- Display Area
- Command Bar

PC Host Connect Mode

The Host Interface Program is a DOS windowed environment with full mouse support to allow you to point and click when entering commands.

The Host Interface Program communicates with the Device Programmer via the serial port of the PC. You may use any of the four (COM1 - COM4) ports. Communication is done at 19200 baud to insure fast throughput. Communication will be established with the Device Programmer prior to any transfers taking place.

Command Line Options

PICSTART-16C can be invoked with the following command:

```
MPS16C.EXE [/n] [/filename] [/ppartname]
```

where [ ] implies optional arguments to the command

- **n** = 1|2|3|4  COM port selection. Invalid parameter will be flagged with an error message. “Command Line Parameter [%s] not recognized”. Program does not execute and returns to DOS. COM1 is default selection.
- **filename** = string variable describing a DOS file. Absolute file name as well as Relative file name (with respect to working directory) will be accepted. If file can not be found or opened, an error message “can not find or open file” will be displayed in a message box after PICSTART-16C screen comes up.
partname = 64/74. Part number selection. To make it user friendly, accept also the following formats: 64, 16C64, C64 etc. The string match should be case insensitive. Invalid parameter will be flagged with an error message “Command Line Parameter [%s] not recognized”. Program does not execute and returns to DOS.

Examples:

MPS16C.EXE /1 /fmyfile.hex /p64
MPS16C.EXE /3 /f:d:\mydir\myfile.hex /p16c64
MPS16C.EXE /h displays help
MPS16C.EXE /? displays help

Menu Bar

The Menu Bar allows you to perform operations and to setup the system for programming. The Menu Bar has six menu selections:

File  Edit  Program  Options  Window  Help

Each pulldown menu item has one highlighted letter in its name. This letter, when pressed with the ALT button, invokes that menu. For example, ALT-F brings down the File Menu.

Each Pulldown Menu selection has additional selectable items. Some of these selectable items have an associated Hot Key to minimize the number of keystrokes required for a specific task. Menu items with an associated Hot Key evoke a selection from a single keystroke of the Hot Key (except from a dialog box waiting for user entry).
Chapter 6: Host User Interface

File

The File Menu gives you access to the files you will use in programming microcontroller devices.

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open . . . F3</td>
<td>Displays the dialog box for opening a file.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the current program memory, data memory, ID, and fuse settings displayed in the active window. The file is saved in the currently selected directory.</td>
</tr>
<tr>
<td>Save As . .</td>
<td>Allows you to name or rename the file displayed in the active window before saving. The file is saved in the currently selected directory.</td>
</tr>
<tr>
<td>Change Dir . .</td>
<td>Allows you to change the current directory.</td>
</tr>
<tr>
<td>DOS Shell</td>
<td>Exits to DOS. Type Exit, &lt;CR&gt; to return to PICSTART-16C.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exits from PICSTART-16C.</td>
</tr>
</tbody>
</table>

Edit

The Edit Menu

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Buffer ... F4</td>
<td>Displays the dialog box for editing the buffer contents.</td>
</tr>
<tr>
<td>Fill Buffer</td>
<td>Displays the dialog box for filling the buffer with a specific value.</td>
</tr>
<tr>
<td>Clear Buffer</td>
<td>Restores the entire buffer to the unprogrammed (erased) state.</td>
</tr>
<tr>
<td>Clear Fuses</td>
<td>Restores the current fuse settings to their default (erased) state.</td>
</tr>
</tbody>
</table>

(Cont.)
The Program Menu allows you to:

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program F5</td>
<td>Executes a programming cycle and programs/verifies all locations and fuses.</td>
</tr>
<tr>
<td>Program Fuses Only</td>
<td>Only programs/verifies the fuse location.</td>
</tr>
<tr>
<td>Verify F6</td>
<td>Checks contents and device with buffer and fuses. Reports any errors.</td>
</tr>
<tr>
<td>Verify Fuses Only</td>
<td>Checks fuses only and reports any error.</td>
</tr>
<tr>
<td>Blank Check F7</td>
<td>Compares the device contents to the erased state. Displays result and current fuse settings.</td>
</tr>
<tr>
<td>Read F8</td>
<td>Transfers the contents of the device to the buffers.</td>
</tr>
</tbody>
</table>

The Option Menu allows you to select support options:

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Establish Communication</td>
<td>Establishes a connection to the Device Programmer. A default device will be selected based on the socket module installed.</td>
</tr>
<tr>
<td>Comm Ports</td>
<td>Allows you to select and change the com port connecting to the Device Programmer. Valid com ports are COM 1 through COM 4.</td>
</tr>
</tbody>
</table>
Chapter 6: Host User Interface

Windows

The Windows Menu allows you to manipulate displayed windows.

<table>
<thead>
<tr>
<th>Windows Pulldown Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection</td>
</tr>
<tr>
<td>-----------</td>
</tr>
<tr>
<td>Buffer Display</td>
</tr>
<tr>
<td>Resize/Move</td>
</tr>
<tr>
<td>Option</td>
</tr>
<tr>
<td>Move Window</td>
</tr>
<tr>
<td>Resize Window</td>
</tr>
<tr>
<td>Fast Move</td>
</tr>
<tr>
<td>ESC</td>
</tr>
<tr>
<td>Zoom</td>
</tr>
<tr>
<td>Next Window</td>
</tr>
<tr>
<td>Close Window</td>
</tr>
</tbody>
</table>

Help

The Help Menu

<table>
<thead>
<tr>
<th>Help Pulldown Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection</td>
</tr>
<tr>
<td>------------</td>
</tr>
<tr>
<td>Context Sensitive Help</td>
</tr>
<tr>
<td>Index Help</td>
</tr>
<tr>
<td>About This Version</td>
</tr>
</tbody>
</table>
Display Area

The display area is a work space for setting up files that you will use to program microcontroller devices. The display area has the following controls:

<table>
<thead>
<tr>
<th>Display Area Controls</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Function/Feature</td>
</tr>
<tr>
<td>Highlighted (Active) Window</td>
</tr>
<tr>
<td>Next (Alt F6)</td>
</tr>
<tr>
<td>Scroll Bars</td>
</tr>
<tr>
<td>Cancel Box ==[■]==</td>
</tr>
<tr>
<td>ESC</td>
</tr>
</tbody>
</table>

Command Bar

The six Command Bar commands allow you to quickly perform the basic device programming operations, and exit from the Host Interface Program.

Note: The Device Programmer establishes communication prior to any programming operation. If communication is lost, the operation will not be performed.

<table>
<thead>
<tr>
<th>Command Bar Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
</tr>
<tr>
<td>Alt-X Exit</td>
</tr>
</tbody>
</table>

Note: Any changes to the screen window will not be saved upon exit. Therefore, you must save prior to issuing an exit command.
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F4 Edit</td>
<td>Allows you to Edit, or Fill a file with a constant value.</td>
</tr>
<tr>
<td>Edit</td>
<td>Opens the Edit Address dialog box for editing the current display window.</td>
</tr>
<tr>
<td>Fill</td>
<td>Opens the Fill Buffer dialog box for filling an address range in the current display window with a constant value.</td>
</tr>
<tr>
<td></td>
<td>Refer to Editing the Display Window in Chapter 5 for additional information.</td>
</tr>
<tr>
<td>F5 Program</td>
<td>Press F5 to start a programming cycle for the selected device. The Host Interface Program first requests a blank safety check by the Device Programmer to avoid reprogramming a non-blank device.</td>
</tr>
<tr>
<td></td>
<td>The Host Interface Program then transfers the data from the PC Host Screen Window to the Device Programmer one location at a time.</td>
</tr>
<tr>
<td></td>
<td>The Device Programmer next programs the data microcontroller device loaded in the socket.</td>
</tr>
<tr>
<td></td>
<td>Finally, the Device Programmer verifies all programmed memory locations in the device, and displays any errors (program or verify) in a new error window. If no errors occurred, the device programmed successfully.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>F6 Verify</strong></td>
<td>Press <strong>F6</strong> to start a verify cycle for the selected device.</td>
</tr>
<tr>
<td></td>
<td>The Host Interface Program first requests that the Device Programmer verify all programmed memory locations in the device.</td>
</tr>
<tr>
<td></td>
<td>The Device Programmer verifies the programmed memory locations in the device by comparing the contents of its memory to the contents of the microcontroller device. Errors will be reported in a separate error window at the PC Host.</td>
</tr>
<tr>
<td><strong>F7 Blank</strong></td>
<td>Press <strong>F7</strong> to blank check the selected device. The Host Interface Program requests that the Device Programmer check the microcontroller device to verify that all locations contain ones (the erased state). Blank checks are useful during the development process.</td>
</tr>
<tr>
<td><strong>F8 Read</strong></td>
<td>Press <strong>F8</strong> to start a read cycle for the selected device.</td>
</tr>
<tr>
<td></td>
<td>The Device Programmer reads the microcontroller device contents and transfers in the contents of the device programmer internal memory to the PC and displays the contents on PC Host screen window.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> It is very important to select the proper device prior to issuing a Read command to avoid corrupting the contents of the device or the buffer. If you issue a Read command before setting up to do so, damage can result.</td>
</tr>
</tbody>
</table>
Appendix A. BBS Support

Keeping Current with Microchip Systems

Microchip Technology endeavors at all times to provide the best service and responsiveness possible to its users. The Microchip Technology Systems BBS is one mechanism to facilitate this process.

**Note:** The best way to keep current with Microchip systems is to register.

The BBS is supported as a service to its customers. This is where all of the most recent information regarding systems products can be found. The BBS is monitored several times a week for questions. Truly urgent issues should not be left with the BBS, but referred to your local distributor, sales office or FAE.

The BBS is an evolving product. Details of its operation will not be found here. This chapter provides a brief discussion of the general services available.

This chapter also describes the Microchip software release numbering scheme.

**Highlights**

The highlighted points in this chapter include:

- Connecting to Microchip BBS
- Using the Bulletin Board
  - Special Interest Groups
  - Files
  - Mail
- Software Releases
Connecting to Microchip BBS

Connect world wide to the Microchip BBS using the CompuServe® communications network. In most cases a local call is your only expense. The Microchip BBS connection does not use CompuServe membership services. Therefore, you do not need CompuServe membership to join Microchip's BBS.

Access to the bulletin board is 24 hours per day, barring technical or mechanical difficulties.

The procedure to connect will vary slightly from country to country. Please check with your local CompuServe agent for details if you have a problem. CompuServe services allow multiple users at baud rates up to 9600.

To connect:

1. Set your modem to 8-bit, No parity, and One stop (8N1). This is not the normal CompuServe setting which is 7E1.
2. Dial your local CompuServe phone number.
3. Depress <ENTER> and a garbage string will appear because CompuServe is expecting a 7E1 setting.
4. Type +, depress <ENTER> and Host Name: will appear.
5. Type MCHIPBBS, depress <ENTER> and you will be connected to the Microchip BBS.

To find CompuServe's phone number closest to you, set your modem to 7E1 and dial (800) 848-4480 for 300-2400 baud or (800) 331-7166 for 9600 baud connection. If you are dialing from overseas, you may call (614) 457-1550 for voice information on your local CompuServe number.

After the system responds with Host Name:, type

    NETWORK, depress <ENTER> and follow CompuServe's directions.
Using the Bulletin Board

The bulletin board is a multifaceted tool. It can provide you with information on a number of different topics.

• Special Interest Groups
• Files
• Mail
• Bug Lists
• Technical Assistance

Special Interest Groups

Special Interest Groups, or SIGs as they are commonly referred to, provide you with the opportunity to discuss issues and topics of interest with others that share your interest or questions. They may be able to provide you with information not available by any other method because of the broad background of the PIC16/17 user community.

There are SIGs for most Microchip systems, including:

• PRO MATE™
• PICMASTER™
• MPASM
• Utilities
• Bugs

These groups are monitored by the Microchip staff.

Files

The Microchip BBS is used regularly to distribute technical information, Application Notes' source code, errata sheets, bug reports, and interim patches for Microchip systems software products. Users can contribute files for distribution on the BBS. These files will be monitored, scanned and approved or disapproved by the moderator of the SIG to which the file is submitted. No executable files are accepted from the user community in general to limit the spread of computer viruses.
Mail

The BBS can be used to distribute mail to other users of the service. This is one way to get answers to your questions and problems from the Microchip staff, as well as keeping in touch with fellow Microchip users worldwide.

Consider mailing the moderator of your SIG, or the SYSOP if you have ideas or questions about Microchip products, or the operation of the BBS. Be aware, though, that the SIGs are moderated only about once per day. Truly urgent questions should be referred to your local distributor, sales representative or FAE. They are your first line of defense.

Software Releases

Software products released by Microchip are referred to by version numbers. Version numbers use the form:

\[ xx.yy.zz \ <\text{status} > \]

Where \( xx \) is the major release number, \( yy \) is the minor number and \( zz \) is the intermediate number. The \text{status} field displays one of the following categories:

- Alpha
- Intermediate
- Beta
- Released

Production releases are numbered with major and minor version numbers like:

\[ 3.04 \ \text{Released} \]

Alpha, Beta and Intermediate releases are numbered with the major, minor and intermediate numbers:

\[ 3.04.01 \ \text{Alpha} \]

Alpha Release

Alpha designated software is engineering software that has not been submitted to any quality assurance testing. In general, this grade of software is intended for software development team access only, but may be sent to selected individuals for conceptual evaluation. Once Alpha grade software has passed quality assurance testing, it may be upgraded to Beta or Intermediate status.
Intermediate Release

Intermediate released software represents changes to a released software system and is designated as such by adding an intermediate number to the version number. Intermediate changes are represented by:

- Bug Fixes
- Special Releases
- Feature Experiments

Intermediate released software does not represent our most tested and stable software. Typically, it will not have been subject to a thorough and rigorous test suite, unlike production released versions. Therefore, users should use these versions with care, and only in cases where the features provided by an intermediate release are required.

Intermediate releases are primarily available through the BBS.

Beta Release

Preproduction software is designated as Beta. Beta software is sent to Applications Engineers and Consultants, FAE's and select customers. The Beta Test period is limited to a few weeks. Software that passes Beta testing without having significant flaws, will be production released. Flawed software will be evaluated, repaired and updated with a new revision number for a subsequent Beta trial.

Production Release

Production released software is software shipped with tool products. Example products are PRO MATE™, PICSTART™ and PICMASTER™. The Major number is advanced when significant feature enhancements are made to the product. The minor version number is advanced for maintenance fixes and minor enhancements. Production released software represents Microchip's most stable and thoroughly tested software.

There will always be a period of time when the Production Released software is not reflected by products being shipped until stocks are rotated. You should always check the BBS for the current production release.
# Appendix B. Error Messages

## Introduction

The error messages listed in this chapter give you additional information suggesting possible actions you might take. This chapter also contains informative messages.

## Highlights

This chapter lists error messages and informative messages alphabetically under the following headings:

- Host Interface Program Messages

## Host Interface Program Messages

The Host Interface Program displays the following error messages. Each error message listed contains one or more possible solutions to help you recover, should you receive the message.

<table>
<thead>
<tr>
<th>Messages</th>
<th>Discussion and Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bad HEX Record</td>
<td>Part of the HEX file is incorrect.</td>
</tr>
<tr>
<td></td>
<td><strong>Possible Solution:</strong></td>
</tr>
<tr>
<td></td>
<td>Retry the operation. If the problem persists, reassemble the</td>
</tr>
<tr>
<td></td>
<td>HEX file using INHX8M bit format.</td>
</tr>
<tr>
<td></td>
<td>Verify that the selected device is the one you want.</td>
</tr>
</tbody>
</table>

| Cannot open (file name) for     | The software cannot open the specified file for reading.     |
| reading                          | **Possible Solutions:**                                      |
|                                 | Enter the correct file name.                                 |
|                                 | Select the directory containing the desired file.            |
|                                 | Verify that the file exists.                                |

<p>| Cannot open file                | The software cannot open the specified file.                 |
|                                 | <strong>Possible Solutions:</strong>                                      |
|                                 | Enter the correct file name.                                 |
|                                 | Select the directory containing the desired file.            |</p>
<table>
<thead>
<tr>
<th>Error Description</th>
<th>Message</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comm Error</td>
<td>The software could not connect to the Device Programmer, or the Host Interface Program is not communicating with the Device Programmer.</td>
<td>Power-Cycle the Device Programmer and Restart.</td>
</tr>
<tr>
<td>Could not open help file</td>
<td>The help file is not in the current directory.</td>
<td>From the <strong>File</strong> ➤ <strong>Change Dir</strong>... pulldown menu, select the directory containing the help file.</td>
</tr>
<tr>
<td>Device Erased</td>
<td>A blank check on the installed device showed that the device has been erased (contains all one's).</td>
<td></td>
</tr>
<tr>
<td>Device Not Blank</td>
<td>A blank check on the installed device showed that the device is already programmed.</td>
<td></td>
</tr>
<tr>
<td>Device Not Blank... Continue ??</td>
<td>The installed device is already programmed.</td>
<td>You are trying to reprogram a device. If you really want to reprogram the device, then:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select Yes to reprogram the device, or</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select No to abort reprogramming the device.</td>
</tr>
</tbody>
</table>
## Appendix B: Error Messages

<table>
<thead>
<tr>
<th>Error Window (Program or Verify)</th>
<th>The data displayed in the window does not match the data on the device.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Error window data displays as follows: Address Good Data Bad Data</td>
</tr>
<tr>
<td></td>
<td>(Screen) (Device)</td>
</tr>
<tr>
<td></td>
<td><strong>Possible Solutions:</strong></td>
</tr>
<tr>
<td></td>
<td>Load a device in the socket.</td>
</tr>
<tr>
<td></td>
<td>Load a device that is not programmed.</td>
</tr>
<tr>
<td></td>
<td>Load a device that is not code protected.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>File Address Out of Range</th>
<th>You attempted to load a HEX file that contains an address not supported by the selected device.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Possible Solutions:</strong></td>
</tr>
<tr>
<td></td>
<td>Verify that the device selected is the one you want.</td>
</tr>
<tr>
<td></td>
<td>Verify that the file selected is the one you want.</td>
</tr>
<tr>
<td></td>
<td>Verify that the HEX file uses the INHX8M bit format. If not, reassemble the HEX file using INHX8M bit format.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>File Not Generated</th>
<th>Informational Prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The software could not create or write to a file, and therefore did not generate a serialization file.</td>
</tr>
<tr>
<td></td>
<td><strong>Possible Solution:</strong></td>
</tr>
<tr>
<td></td>
<td>Try again.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Fuse Error</th>
<th>Displays the current fuse options as read from the device when a difference exists between the fuse settings at the Host Interface Program and the device.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Possible Solution:</strong></td>
</tr>
<tr>
<td></td>
<td>Try again.</td>
</tr>
</tbody>
</table>
### HEX File Appears to be for a Different Family Type

The HEX file you are using may be intended for a different device family.

<table>
<thead>
<tr>
<th>Family</th>
<th>Word Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>PIC16C5X</td>
<td>12 Bits</td>
</tr>
<tr>
<td>PIC16C6X, 7X, 8X</td>
<td>14 Bits</td>
</tr>
<tr>
<td>PIC17C42</td>
<td>16 Bits</td>
</tr>
</tbody>
</table>

**Possible Solutions:**
- Check your device selection.
- Verify that you are using the HEX file you want.

### Invalid Address

You entered an invalid address when editing the window with Edit (F4).

**Possible Solution:**
Enter a valid address.

### Invalid drive or directory

The directory path that you entered is not valid.

**Possible Solution:**
Enter a valid path.

### Invalid Entry

You entered an invalid data value in the buffer window when editing the window with Edit (F4).

**Possible Solution:**
Enter a valid data value.

### Invalid Range

You entered an invalid range in the buffer window when editing the window with Edit (F4).

**Possible Solution:**
Enter a valid range.

### Not enough memory available to complete operation.

Only enough memory is available on the PC Host to display part of the buffer.

**Possible Solution:**
Exit and free up memory.
### Appendix B: Error Messages

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
<th>Possible Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not enough memory to display entire buffer. Only first nnnn bytes of the file will be displayed.</td>
<td>The remaining available memory is too low to display the entire buffer.</td>
<td>Exit and free up memory.</td>
</tr>
<tr>
<td>PICSTART-16C Not Responding! Check Comm Port or Select Device on PICSTART.</td>
<td>The Host Interface Program is not communicating with the Device Programmer.</td>
<td>Possible Solutions: Try again. Turn ON the Device Programmer. Verify that the Comm Port is transmitting a signal. Select a device on the Device Programmer. Check the serial data cable from the Device Programmer, and refer to Hardware Installation in Chapter 2.</td>
</tr>
<tr>
<td>Program Complete Informational Prompt</td>
<td>The software successfully programmed the installed device.</td>
<td></td>
</tr>
<tr>
<td>Program Error</td>
<td>The software could not program the device.</td>
<td>Possible Solutions: Position the device correctly in the socket. Load a device in the socket. Load the correct device type in the socket. Load a device that you know is good. Verify that the serial cable is connected.</td>
</tr>
<tr>
<td>Receive Overflow Error 1[2][3]4</td>
<td>The PC host received more information than it could read in the allocated reading time.</td>
<td>Possible Solution: Try again.</td>
</tr>
<tr>
<td>Serial Out Data Timeout</td>
<td>The Device Programmer is not reading the available data from the PC host.</td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Possible Solutions:</strong></td>
<td>Turn ON the Device Programmer.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Try again.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Check the serial data cable from the Device Programmer, and refer to</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hardware Installation in Chapter 2.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Serial Out RTS Timeout</th>
<th>The Device Programmer is not reading the available data from the PC host.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Possible Solutions:</strong></td>
<td>Turn ON the Device Programmer.</td>
</tr>
<tr>
<td></td>
<td>Try again.</td>
</tr>
<tr>
<td></td>
<td>Check the serial data cable from the Device Programmer, and refer to</td>
</tr>
<tr>
<td></td>
<td>Hardware Installation in Chapter 2.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Serial Port in timeout</th>
<th>The PC host is waiting for data from the Device Programmer.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Possible Solutions:</strong></td>
<td>Turn ON the Device Programmer.</td>
</tr>
<tr>
<td></td>
<td>Try again.</td>
</tr>
<tr>
<td></td>
<td>Check the serial data cable from the Device Programmer, and refer to</td>
</tr>
<tr>
<td></td>
<td>Hardware Installation in Chapter 2.</td>
</tr>
</tbody>
</table>
Appendix C. Troubleshooting

Introduction

The troubleshooting information in this chapter can help you resolve typical problems in programming microcontroller devices.

Highlights

The troubleshooting information in this chapter is listed alphabetically and includes:

• Communication Failure
• Disabled Mouse
• Establishing Communication
Typical Problems in Programming Devices

Communication Failure

The following table gives the data for connecting the PICSTART-16C Device Programmer to a 25-Pin serial port. Connect the corresponding terminals on each line of the table. If communication fails, check your PC serial port.

<table>
<thead>
<tr>
<th>25-Pin Female (PC Host)</th>
<th>9-Pin Male (PICSTART-16C)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 TX</td>
<td>3 RX</td>
</tr>
<tr>
<td>3 RX</td>
<td>2 TX</td>
</tr>
<tr>
<td>20 DTR</td>
<td>4 Data Ready</td>
</tr>
<tr>
<td>7 Ground</td>
<td>5 Ground</td>
</tr>
<tr>
<td>6 DSR</td>
<td>6 pulled up to +5 volts</td>
</tr>
<tr>
<td>4 RTS</td>
<td>7 CTS</td>
</tr>
<tr>
<td>5 CTS</td>
<td>8 RTS</td>
</tr>
</tbody>
</table>

Disabled Mouse

If your mouse is on COM1 and you do not specify a different serial port then the Device Programmer will initialize COM1 and disable your mouse.

Establishing Communication

A flashing message Establishing Communication indicates that the Device Programmer is trying to initialize a mouse or a modem. Type Control C (^C) to exit.
Index

A
Active Window 16
ASCII Table 4

B
Basic Functions
Device Programmer 17, 18
PC Host Mode 17, 19
BBS 37
Bug Lists 39
Connecting to 36
Files 37
Mail 38
Special Interest Groups 37
Using 37
Support 35
Blank Device (F5) 18, 33
Checking 18
Bulletin Board System see BBS

C
Cable Requirements 10
Checksum 5
COM 5
Port 5
Close (F9) 31
Command Bar
Alt-X Exit 32
F4 Edit 33
F5 Program 33
F6 Verify 34
F7 Blank 34
F8 Read 34
Communication
Baud Rate 27
Serial Port 12
Config
Fuses 25
Current Directory
Change 29
Current Program
Display Contents of 32

D
Data Cable 10
Data Transfer Paths 11
DCE 5
Device
Microcontrollers 18
Reading Master 18
Selection 18
Device Programmer 18
Connection to 11
Display Area
Cancel Box 32
Highlighted Window 32
Next 32
Scroll Bars 32
Display Window
Editing 23
Also see Screen
Documentation Conventions 4

E
Edit (F4) 24
Address 24
Buffer 24
Edit a File 24
Fill a File 25
Error Messages
Host Interface 41
Examples
PC Host 21
Exit (Alt-X) 29

F
Field Application Engineer (FAE) 35
File
Change Dir 29
DOS Shell 29
Exit 29
Host Interface Program 27
Save 29
Save As 29
Open 29
Fill Buffer 29

G

H
Handshaking 10
Hardware Installation 9
HEX Data
8-Bit Merged HEX Format
(INHX8M) 13
Load HEX File 20
Host Interface Program 15
Exit 29
Host Mode 19 - 22
Also see PC Host Mode

I
Installing
MPS16CEXE 11
Software 11

M
Menu
Hot Key 28
Menu Bar
Edit 29
File 29
Help 31
Program 30
Option 30
Windows 31

Continued...